PURCHASE AGREEMENT

THIS AGREEMENT is made and entered into this day of ,2019, by
and between the CITY OF BILLINGS, MONTANA, a municipal corporation organized and
existing under the laws of the State of Montana, P.O. Box 1178, Billings, Montana 59103,
hereinafter referred to as “City,” and, Enviro-Care, hereinafter referred to as “Seller.”

In consideration of the mutual covenants and agreements herein contained, the receipt and
sufficiency whereof being hereby acknowledged, the parties hereto agree as follows:

1. PRODUCT PURCHASED: Seller agrees to sell and City agrees to purchase the
goods (“Product™) as described below and per written City’s specifications and Seller’s proposal
attached hereto as Exhibit “A,” which are incorporated into this agreement by this reference. The
Product being purchased consists of:

Item Price
Perforated Filter Screen $148.988.00
FSM FRS2 — 1000x60/6

2, Price: The City agrees to pay One Hundred Forty Eight Thousand Nine Hundred
Eighty Eight and No/100 Dollars ($148,988.00) as the purchase price. All prices are inclusive of any
applicable local, state or federal taxes that may be applied to the product to be purchased. The
purchase price is free on board at the place of delivery and Seller may not impose any additional,
shipping, delivery or storage charges.

3. Delivery and Payment: Seller agrees to deliver the above-described goods or
product to City by December 31, 2019 unless otherwise provided in this Agreement. Delivery will
occur at City of Billings, MT Water Reclamation Facility or at a place otherwise selected by City.

Upon delivery, City may inspect the goods or product to ensure that it meets City specifications, and
Seller may obtain specifications from City upon request. If the Product meets City specifications,
City shall tender the purchase price stated above to Seller through the City’s normal claim process.

4. Specifications: Seller agrees that this Product complies with the City’s specifications
provided to Seller and with the Seller’s proposal thereto as accepted by the City. Unless otherwise
agreed to by the City, the City’s specifications govern and control in the event of inconsistencies
with the Seller’s response to the same.
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s. Indemnity, Insurance and Bonds: Seller agrees to indemnify, defend and save City,
its officers, agents and employees harmless from any and all losses, damage and liability occasioned
by, growing out of, or in any way arising or resulting from any intentional or negligent act on the part
of Seller or its agents or employees. For this purpose, Contractor shall provide City with proof
of both Commercial General liability and automobile insurance each issued by a reliable
company or companies for personal injury and property damage, in an amount not less than
$1.5 million per occurrence. The City shall be named as an additional insured on all policies
other than professional liability and worker’s comp. The insurance must be in a form suitable
to City.

Seller shall furnish an approved Performance Bond and a Labor and Materials Payment
Bond, each in the amount of one hundred percent (100%) of the contract amount.

6. Nondiscrimination: Seller agrees that all hiring by Seller of persons performing this
Agreement will be on the basis of merit and qualification and will not discriminate on the basis of
race, color, religion, creed, political ideas, sex, age, marital status, physical or mental disability, or
national origin.

The Contractor and subcontractor shall abide by the requirements of 41'CFR 60-300.5(a) and
41 CFR 60-741.5(a), which prohibit discrimination against qualified protected veterans and/or
qualified individuals on the basis of disability, and requires affirmative action by covered prime
contractors and subcontractors to employ and advance in employment qualified protected veterans
and individuals with disabilities.

7. Default and Termination: If Seller fails to deliver the goods or product as set forth
in Paragraphs 2 and 3 above, or violates any provision of this Agreerﬁent, or if the goods or product
fails to meet City’s specifications, City may, at its option, declare the Seller in default and
immediately cancel and rescind this Agreement. Thereafter, City may procure substitute goods or
product to replace the goods or product described herein. In such event, Seller is liable to City for
the difference between the price set forth herein and the price paid by City for replacement goods or
product. Additionally, the City may pursue any other remedy it has at law or in equity.

8. Warranty: Unless superseded or supplemented by an express warranty, Seller
represents and warrants that the Product are covered by implied warranties for merchantability and
fitness for the particular purpose for which they have been purchased.

9. Assignment: Seller may not assign this Agreement or any of its rights hereunder
without the express written consent of City.

W.0. 19-34, WRF HW Screen Equipment Procurement



10.  Entire Agreement: This Agreement, including its appendices, if any, is the entire
understanding between the parties relating to the subject matter contained herein. No agent or
representative of either party has authority to make any representations, statements, warranties or
agreements not herein expressed and all modifications or amendments of this agreement, including
the appendices, must be in writing and signed by an authorized representative of each of the parties
hereto.

11.  Governing Law and Venue: This Agreement shall be construed and enforced in
accordance with the laws of the State of Montana. Venue for any suit between the parties arising out
of this Agreement shall be the State of Montana Thirteenth Judicial District Court, Yellowstone
County.

IN WITNESS WHEREOF, the parties hereto have executed this instrument the day and
year first above written.

CITY OF BILLINGS, MONTANA

SELLER (Print Business Name Above)

By By
WILLIAM A. COLE
MAYOR Print Name
Print Title
APPROVED AS TO FORM
By

BRENT BROOKS, City Attorney
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Scope of Supply

Project:
City of Billings, MT
W.O 19-34: Water Reclamation Facility Headworks Screen Procurement

Specification:
46 2153 Perforated Plate Screens — May 2019

Equipment:
FSM FRS2 -1000x60/6 Perforated

Filter Screen
(IDENTICAL to the three (3) existing
units)

Represented By:

The Coombs Hopkins Company
Scott Forsling

Phone: 435-659-7199

Email: scott@coombshopkins.com

Regional Sales Manager:
Enviro-Care
Alan Spratt
Phone: 224-302-0304

Email: aspratt@enviro-care.com

Project No.. WEC216316
June 5, 2019

i‘_‘. ®
iE Enviro-Care

A WAMGROUP* Company
1570 St. Paul Avenue - Gurnee IL 60031
P. 815.636.8306
F. 847.672.7968

WWW,eNnviro-care.com
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SPECIFICATION: 46 2153 — Perforated Plate

ADDENDA: None

ITEM:

E Enviro-Care

A WAMGROUP* Compony

Screens

"A" - One (1) FSM Perforated Filter
Screen Model FRS2 - 1000 x 60/6.

FSM is the original equipment
manufacturer (OEM) for the existing
three (3) FSM Perforated Filter Screens
currently operating at the Billings WRF
and therefore is the only —
manufacturer that can provide and guarantee the supply of an /DENTICAL unitas  |.* ;
required per Section 46 21 53 — Paragraph 1.1.A.2.

EQUIPMENT NUMBER: HWB-SCRN-4

BASIS OF DESIGN (EACH)

Application: Municipal Wastewater

Average Annual Flow (Per Screen, 2 Screens in Service): 8.5 mgd

Average Wet Weather Flow (Per Screen): 13 mgd

Peak Flow (Per Screen, 3 Screens in Service): 20 mgd

Downstream Water Level: 3.5 feet @ peak flow

Headloss: 12 inches @ PF with 20% blinding
Screen Perforated Opening: 6 mm

Angle of Screen: 60 degrees from horizontal

Channel Width: 4.0 feet

Channel Depth: 7.5 feet

Floor Recess: 6-inches

Discharge Height: 3.5 feet above finished floor elevation
Maximum Screen Height: 9.0 feet above finished floor elevation
Wash Water: 15 gpm at 40 — 60 psi

PERFORATED PANEL TRAVELING BELT SCREEN (EACH)

Fully automatic self-cleaning FSM screen complete with all appurtenances — 304L stainless
steel.

Main frame constructed from type 304L stainless steel.

Flanged baseplate with pivot assembly for mounting screen assembly to top of channel -
304L stainless steel. Pivot assembly allows screen to be pivoted out of channel.

Screen support rails from UHMW-PE provided front and back on each side of frame.
Replaceable UHMW-PE seals mounted to each side of frame.

Page 2 of 6
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A WAMGROUP" Compony

Replaceable bottom seals — UHMW-PE, Buna-N rubber, and triple layer polyester brush
with 304L stainless steel adjustable holder.

Perforated filter screen elements with 1/4” (6 mm nominal) perforations from 3 mm thick
(12 gauge) from type 304L stainless steel, bolted to drive chain with 304 stainless steel bolt
ny-lock nuts and washers.

Stainless steel screen drive chain from 304 stainless steel with hardened bushings, and pins
from stainless steel.

Stainless steel chain and screen elements driven by two (2) drive shaft mounted stainless
steel sprockets with minimum thickness of 0.75 inches.

Lower rotating guide sprockets from type 304 stainless steel with life seal bushings and a
stainless steel stub shaft.

Drive tensioners — 304 stainless steel.

Drive system to include a SEW-Eurodrive two-speed/single winding motor 3.0/1.5 HP
1800/900 rpm TEFC (Class 1, Division 2) geardrive motor suitable for 460V/3/60 electrical
supply.

Nylon screen cleaning brush, automatic self-adjusting, with stainless teel drive shaft and 2.0
HP 1760 rpm TEFC (Class 1, Division 2) SEW-Eurodrive geared motor suitable for 460V/3/60
electrical supply.

Rotary Deflector from type 304L stainless steel on back side of screen.

Internal spray system to clean internal surfaces of screen panel from stainless steel with
brass nozzles; complete with manual ball valve and NEMA 4X 120vac solenoid valve.
Removable 304L stainless steel odor control enclosures/covers with clear plexiglass view
panels as specified.

Screenings discharge hood/chute, hinged from type 304L stainless steel with clear
plexiglass view panels as specified. Complete with polypropylene inspection hatches on
each side.

Anchor bolts — 304 stainless steel.

Fasteners — 304 stainless steel.

Shop surface preparation, stainless steel FULL DIP PASSIVATION.

CONTROL PANEL AND INSTRUMENTATION (EACH)

Control panels and instrumentation to be provided by others, not Enviro-Care.

SPARE PARTS (TOTAL)

e © o @ o o

One (1) set of bottom sprockets.

One (1) set of top sprockets.

One (1) set of tension frame bearings.

One (1) complete set of replacement drive chain with master link connection pieces.
One (1) perforated plate panel.

One (1) complete rotating brush assembly.

One (1) set of side and bottom curved seals.

One (1) lower brush seal with rubber.

o o e e T T
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#E Enviro-Care

A WAMGROUP* Compony

e One (1) of each motor (integral to gear reducer spare).
e One (1) of each gear reducer.

FIELD SERVICE (TOTAL)

e Site service of one (1) trip for a total of two (2) days for installation inspection, startup and
operator training.

CLARIFICATIONS/COMMENTS

e 14.A5: For carification, the screen discharge height will be 3.5 feet identical to the three
(3) FSM FRS2 1000x60/6 Perforated Filter Screens currently operating at the Billings WRF.
Per Paragraph 1.1.A.2 the new screen is to be identical to the existing equipment currently
operating at the Billings WWTP.

o 24E4: For clarification, we will provide a discharge hood identical to the three (3) FSM
FRS2 1000x60/6 Perforated Filter Screens currently operating at the Billings WRF. The
discharge hood described is specific for the new model FSM FRS3 perforated plate screen
and cannot be installed on the older model FSM FRS2 perforated plate screen.

OPTIONAL ITEMS

e None.
NOTE: ANY ITEM NOT LISTED ABOVE TO BE FURNISHED BY OTHERS.

EXCLUSIONS

Taxes, electrical wiring, conduit or electrical equipment, piping, valves, or fittings, shimming
material, lubricating oil or grease, shop or field painting, field welding, erection, hoist or lifting
apparatus, detail shop fabrication drawings, unloading, storage, concrete work, civil design, grating,
platforms, stairs, hand railing, dumpster (except as specifically noted).

This proposal section has been reviewed for accuracy and is approved for issue:
By: Beth Emmelot Date: June 5, 2019

Page 4 of 6
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#E Enviro-Care

A WAMGROUP* Company

PRICING

Item Equipment Price
A One (1) FSM Perforated Filter Screen Model FRS2 1000 x 60/6. $148,988.00

Validity:
Prices are valid for a period of 30 days from the date of this proposal.
Warranty Statement and Term:

Enviro-Care Company, Inc. warrants the supplied equipment to the original end user against defects in
workmanship or material under normal use and service in compliance with the original design specifications
and the maintenance requirements and instructions as found in the Operations & Maintenance Manual. All
Enviro-Care supplied equipment is warranted twenty-four (24) months from date of start-up or thirty (30)
months from date of shipment, whichever occurs first.

Warranty Exclusions:

This warranty does not cover costs for standard and/or scheduled maintenance performed, nor does it cover
consumables and Enviro-Care parts that, by virtue of their operation, require replacement through normal
wear (aka: Wear Parts), unless a defect in material or workmanship can be determined by Enviro-Care. Wear
parts are defined as brushes, rollers, spray nozzles, drum seals and other items specifically identified in the
Operations & Maintenance Manual.

Warranty Coverage:

Enviro-Care's liability is limited to the supply or repair of defective parts returned, freight prepaid by buyer to
a location specified by Enviro-Care. Repaired or replacement parts will be shipped to buyer prepaid via
standard ground freight. Express or expedited shipments will be at the expense of the buyer.

Exclusions and Exceptions:

This Warranty excludes damage or wear to equipment caused by misapplication of product, improper
maintenance, accident, abuse, unauthorized alteration or repair, Acts of God, or installation or operation that
is non-compliant with Enviro-Care installation and operations instructions.

Limited Liability:
Enviro-Care shall not under any circumstances be liable for any incidental or consequential damages arising
from loss, damage to property, personal injury or other damage or losses owing to the failure of Enviro-

Care's equipment. The liability of Enviro-Care Company, Inc. is limited as set forth above within the time
period set forth above.

Term: 15% with Submittal Approval
80% Net 30 Days after Shipment
5% Net 30 days after Startup. Startup not to exceed 180 days from equipment delivery.

Taxes: No sales or use taxes have been included in our pricing.

Page 5 of 6
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A WAMGROUP® Company

Freight: Prices quoted are F.O. B. shipping point with freight allowed to a readily accessible location nearest
jobsite. Any claims for damage or loss in shipment to be initiated by purchaser.

Submittals: Full submittals will be supplied approximately 4 to 6 weeks after receipt and acceptance of
purchase order at the Enviro-Care offices.

Shipment: Shipment time is approximately 18 to 20 weeks after receipt of approved submittal is received at
the Enviro-Care offices. Under no circumstances will verbal approval be accepted.

Additional Field Service: This service may be scheduled at $1,250.00 per day plus expenses or is available
through a yearly service contract.

Material of Construction: Enviro-Care is providing the equipment from the type of material specified for this
project. If from 304L stainless steel the concentration of chloride and hydrogen sulfide (H2S) in the
equipment operating environment shall be kept below the following values:

e Chloride <200 mg/L

e Hydrogen Sulfide (H2S) <6ppm
If not already done so, Enviro-Care can provide the equipment from 316L stainless steel for a price adder for
environments that exceed the values noted above.

Please issue Purchase Orders to:
Enviro-Care

1570 St Paul Avenue

Gurnee, IL 60031

Attn: Stephen Rioux
Phone: 224-302-0308
Email: srioux@enviro-care.com
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City of Billings

BILLINGS, MT

W.O. 19-34: Water Reclamation Facility Headworks
Screen Procurement

Contract Documents and Specifications

May 2019

HDR Project No. 233305



PART 1 -

Fxhilif A S

SECTION 01 33 00
SUBMITTALS

GENERAL

1.1 SUMMARY

A. Section Includes:

1.

2.

Mechanics and administration of the submittal process for:
a. Shop Drawings.

b. Samples.

c. Informational submittals.

General content requirements for Shop Drawings.

B. Related Specification Sections include but are not necessarily limited to:

1.
2.
3.
4.

Division 00 - Bidding Requirements, Contract Forms and Conditions of the Contract.
Division 01 - General Requirements.

Section 01 33 04 — Operations and Maintenance Manuals.

Section 46 21 53 — Perforated Plate Screens.

1.2 DEFINITIONS

A. Shop Drawings:

1.
2.

See General Conditions.
Product data and samples are Shop Drawing information.

B. Informational Submittals:

1.

2.

Submittals other than Shop Drawings and samples required by the Contract Documents that
do not require review and/or approval by the Engineer.

Representative types of informational submittal items include but are not limited to:

a. Installed equipment and systems performance test reports.

b. Manufacturer's installation certification letters.

c. Warranties.

d. Service agreements.

For-Information-Only submittals upon which the Engineer is not expected to conduct
review or take responsive action may be so identified in the Contract Documents.

1.3 PREPARATION OF SUBMITTALS

A. General:
1. All submittals and all pages of all copies of a submittal shall be completely legible.
2. Submittals which, in the Engineer’s sole opinion, are illegible will be returned without
review.
3. Minimize extraneous information for equipment and products not relevant to the submittal.
4. Supplies written comments on the submittal drawings shall be in GREEN.
5. SHOP DRAWINGS ARE REQUIRED TO BE SUBMITTED ELECTRONICALLY

IN BLACK AND WHITE. COLOR ONLY TO BE USED IF REQUIRED FOR

CLARITY.

a. Maximum electronic file size is 10 megabytes for transmittal via email. Electronic files
larger than 10 megabytes can be broken up for emailing or copied onto HDR’s FTP site
or guest transfer drive with follow up by and email notice indicating delivery of the
shop drawing,

B. Shop Drawings, Product Data, and Samples:

1.

233305

Scope of any submittal and letter of transmittal:
a. Limited to one (1) Specification Section.
b. Submittals with more than one Specification section included will be rejected.
City of Billings
W.0. 19-34: Headworks Screen Procurement -

SUBMITTALS
013300-1
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¢. Do not submit under any Specification Section entitled (in part) "Basic Requirements"
unless the product or material submitted is specified, in total, in a "Basic Requirements"
Specification Section.

Numbering letter of transmittal:

a. Include as prefix the Specification Section number followed by a series number, "-xx",
beginning with "01" and increasing sequentially with each additional transmittal for that
Specification Section.

b. If more than one (1) submittal under any Specification Section, assign consecutive
series numbers to subsequent transmittal letters.

Describing transmittal contents:

a. Provide listing of each component or item in submittal capable of receiving an
independent review action.

b. Identify for each item:

1) Manufacturer and Manufacturer's Drawing or data number.

2) Contract Document tag number(s).

3) Unique page numbers for each page of each separate item.

¢.  When submitting "or-equal" items that are not the products of named manufacturers,
include the words "or-equal” in the item description.

Supplier’s certification of review and approval:

a. Supplier shall execute Exhibit AA, Supplier's Submittal Certification form, to indicate
Supplier has reviewed and approved the submittal contents.

1) Clearly identify the person who reviewed the submittal and the date it was
reviewed."

b. Submittals containing multiple independent items shall be prepared with each item
listed on the letter of transmittal or on an index sheet for all items listing the discrete
page numbers for each page of each item, which shall be stamped with the Supplier's
review and approval stamp.

1) Each independent item shall have a cover sheet with the transmittal number and
item number recorded.

a) Provide clear space of 3 IN SQ for Engineer stamping.

2) Individual pages or sheets of independent items shall be numbered in a manner that
permits the entire contents of a particular item to be readily recognized and
associated with Supplier's certification.

Resubmittals:

a. Number with original Specification Section and series number with a suffix letter
starting with "A" on a (new) duplicate transmittal form.,

b. Do not increase the scope of any prior transmittal.

c. Provide cover letter indicating how each "B", "C", or "D" Action from previous
submittal was addressed and where the correction is found in the resubmittal.

d. Account for all components of prior transmittal.

1) Ifitems in prior transmittal received "A" or "B" Action code, list them and indicate
"A" or "B" as appropriate.

a) Do not include submittal information for items listed with prior "A" or "B"
Action in resubmittal.

2) Indicate "Outstanding-To Be Resubmitted At a Later Date” for any prior "C" or
"D" Action item not included in resubmittal.

a) Obtain Engineer's approval to exclude items.

Supplier shall not use red color for marks on transmittals.

a. Duplicate all marks on all copies transmitted, and ensure marks are photocopy
reproducible.

b. Engineer will use red marks or enclose marks in a cloud.

Transmittal contents:

a. Coordinate and identify Shop Drawing contents so that all items can be easily verified
by the Engineer.

City of Billings
W.0O. 19-34: Headworks Screen Procurement -
SUBMITTALS
013300-2
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b. Provide submittal information or marks defining specific equipment or materials
utilized on the Project.

1) Generalized product information, not clearly defining specific equipment or
materials to be provided, will be rejected.

c. Identify equipment or material project use, tag number, Drawing detail reference,
weight, and other Project specific information.

d. Provide sufficient information together with technical cuts and technical data to allow
an evaluation to be made to determine that the item submitted is in compliance with the
Contract Documents.

e. Do not modify the manufacturer's documentation or data except as specified herein.

f.  Submit items such as equipment brochures, cuts of fixtures, product data sheets or
catalog sheets not exceeding 11 x 17 IN pages.

1) Indicate exact item or model and all options proposed by arrow and leader.

g.  When a Shop Drawing submittal is called for in any Specification Section, include as
appropriate, scaled details, sizes, dimensions, performance characteristics, capacities,
test data, anchoring details, installation instructions, storage and handling instructions,
color charts, layout Drawings, rough-in diagrams, wiring diagrams, controls, weights
and other pertinent data in addition to information specifically stipulated in the
Specification Section.

1) Arrange data and performance information in format similar to that provided in
Contract Documents.

2) Provide, at minimum, the detail specified in the Contract Documents.

h. If proposed equipment or materials deviate from the Contract Drawings or
Specifications in any way, clearly note the deviation and justify the said deviation in
detail in a separate letter immediately following transmittal sheet. Any deviation from
plans or specifications not depicted in the submittal or included but not clearly noted by
the Supplier may not have been reviewed. Review by the Engineer shall not serve to
relieve the Supplier of the contractual responsibility for any error or deviation from
contract requirements.

8. Samples:

a. Identification:

1) Identify sample as to transmittal number, manufacturer, item, use, type, project
designation, tag number, Specification Section or Drawing detail reference, color,
range, texture, finish and other pertinent data.

2) Ifidentifying information cannot be marked directly on sample without defacing or
adversely altering samples, provide a durable tag with identifying information
securely attached to the sample.

. Include application specific brochures, and installation instructions.

¢. Provide Supplier's review and approval certification stamp or Supplier's Submittal
Certification form as indication of Supplier's checking and verification of dimensions
and coordination with interrelated work.

d. Resubmit revised samples of rejected items.

C. Informational Submittals:
1. Prepare in the format and detail specified in Specification requiring the informational
submittal.

1.4 TRANSMITTAL OF SUBMITTALS

A. Shop Drawings and Samples:
1. Transmit all submittals to:
2. Craig Habben: craig.habben(@hdrinc.com
3. Utilize two (2) copies of attached Exhibit A to transmit all Shop Drawings and samples.

B. Informational Submittals:
1. Transmit under Supplier's standard letter of transmittal or letterhead.

233305 City of Billings
W.O. 19-34: Headworks Screen Procurement -
SUBMITTALS
013300-3
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2.
3.
4.

E)‘(A;b}'/’ A /1/85’_

Submit in triplicate or as specified in individual Specification Section.
Transmit to:
Craig Habben: craig.habben@hdrinc.com

C. Electronic Transmission of Submittals:

1.

whwn

10.

11.

12,

13.

Transmittals shall be made electronically.

a. Use email.

Provide documents in Adobe Acrobat Portable Document Format (PDF), latest version.

Create one (1) PDF file for each equipment Operation and Maintenance Manual.

Do not password protect or lock the PDF document.

Drawings or other graphics must be converted to PDF file format from the original drawing

file format and made part of the PDF document.

a. Scanning of drawings is to be used only where actual file conversion is not possible and
drawings must be scanned at a resolution of 300 dpi or greater.

b. Required signatures may be applied prior to scanning for transmittal.

Electronic drawings shall be formatted to be at full-scale (or half-scale when printed to

11x17).

a. Do not reduce drawings by more than 50% in size.

b. Reduced drawings shall be clearly marked "HALF-SIZE" and shall scale accurately at
that size.

Rotate sheets that are normally viewed in landscape mode so that when the PDF file is

opened the sheet is in the appropriate position for viewing.

Create bookmarks in the bookmarks panel for the Operation and Maintenance Manual

cover, the Table of Contents and each major section of the Table of Contents.

Using Adobe Acrobat Standard or Adobe Acrobat Professional, set the PDF document

properties, initial view as follows:

Select File > Properties=> Initial View.

Select the Navigation tab: Bookmarks Panel and Page.

Select the Page layout: Single Page.

Select the Magnification: Fit Page.

Select Open to page: 1.

Set the file to open to the cover page with bookmarks to the left, and the first bookmark

linked to the cover page.

Set the PDF file "Fast Web View" option to open the first several pages of the document

while the rest of the document continues to load.

a. To do this:

1) Select Edit->Preferences=> Documents-> Save Settings.
2) Check the Save As optimizes for Fast Web View box.

File naming conventions:

a. File names shall use a "ten dot three" convention (XXXXXX-YY-Z.PDF) where
XXXXXX is the Specification Section number, YY is the Shop Drawing Root number
and Z is an ID number used to designate the associated volume.

Labeling:

a. As a minimum, include the following labeling on all CD-ROM discs and jewel cases:
1) Project Name.

2) Equipment Name and Project Tag Number.
3) Project Specification Section.

4) Manufacturer Name.

5) Vendor Name.

Binding:

a. Include labeled CD(s) in labeled jewel case(s).

1) Bind jewel cases in standard three-ring binder Jewel Case Page(s), inserted at the
front of the Final paper copy submittal.

2) Jewel Case Page(s) to have means for securing Jewel Case(s) to prevent loss (e.g.,
flap and strap).

o o o

City of Billings
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1.5 ENGINEER'S REVIEW ACTION
A. Shop Drawings and Samples:

233305

1.

Items within transmittals will be reviewed for overall design intent and will receive one (1)

of the following actions:

a. A -FURNISH AS SUBMITTED.

b. B -FURNISH AS NOTED (BY ENGINEER).

c. C-REVISE AND RESUBMIT.

d. D-REJECTED.

e. E-ENGINEER'S REVIEW NOT REQUIRED.

Submittals returned with Action "A" or "B" are considered ready for fabrication and

installation,

a. If for any reason a submittal that has an "A" or "B" Action is resubmitted, it must be
accompanied by a letter defining the changes that have been made and the reason for
the resubmittal.

b. Destroy or conspicuously mark "SUPERSEDED" all documents having previously
received "A" or "B" Action that are superseded by a resubmittal.

Submittals with Action "A" or "B" combined with Action "C" (Revise and Resubmit) or

"D" (Rejected) will be individually analyzed giving consideration as follows:

a. The portion of the submittal given "C" or "D" will not be distributed (unless previously
agreed to otherwise at the Preconstruction Conference).

1) One (1) copy or the one (1) transparency of the "C" or "D" Drawings will be
marked up and returned to the Supplier.
a) Correct and resubmit items so marked.

b. Items marked "A" or "B" will be fully distributed.

¢. Ifaportion of the items or system proposed are acceptable, however, the major part of
the individual Drawings or documents are incomplete or require revision, the entire
submittal may be given "C" or "D" Action.

1) This is at the sole discretion of the Engineer.

2) In this case, some Drawings may contain relatively few or no comments or the
statement, "Resubmit to maintain a complete package."

3) Distribution to the Owner and field will not be made (unless previously agreed to
otherwise).

Failure to include any specific information specified under the submittal paragraphs of the

Specifications will result in the submittal being returned to the Supplier with "C" or "D"

Action.

Calculations required in individual Specification Sections will be received for information

purposes only, as evidence calculations have been stamped by the professional as defined in

the specifications and for limited purpose of checking conformance with given performance
and design criteria. The Engineer is not responsible for checking the accuracy of the
calculations and the calculations will be returned stamped "E. Engineer's Review Not

Required" to acknowledge receipt.

Supplier shall furnish required submittals with sufficient information and accuracy to obtain

required approval of an item with no more than three submittals. Engineer will record

Engineer’s time for reviewing a fourth or subsequent submittal of a Shop Drawings, sample,

or other item requiring approval, and Supplier shall be responsible for Engineer’s charges to

Owner for such time. Owner may impose a set-off against payments due to Supplier to

secure reimbursement for such charges.

Transmittals of submittals which the Engineer considers as "Not Required" submittal

information, which is supplemental to but not essential to prior submitted information, or

items of information in a transmittal which have been reviewed and received "A" or "B"

action in a prior submittal, will be returned with action "E. Engineer's Review Not

Required."

Samples may be retained for comparison purposes.

a. Remove samples when directed.

City of Billings
W.0. 19-34; Headworks Screen Procurement -
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b. Include in bid all costs of furnishing and removing samples.
9. Approved samples submitted or constructed, constitute criteria for judging completed work.
a. Finished work or items not equal to samples will be rejected.

PART 2 - PRODUCTS - (NOT APPLICABLE TO THIS SPECIFICATION SECTION)

PART 3 - EXECUTION - (NOT APPLICABLE TO THIS SPECIFICATION SECTION)

END OF SECTION

233305 City of Billings
W.0. 19-34: Headworks Screen Procurement -
SUBMITTALS
013300-6



Exhibitd- A MHas—

BXHIBITA Shop Drawing Transmittal No.

(Spec Section) (Series)

Project Name: Date Received:
Project Owner: Checked By:
l§upplier: HDR Engineering, Inc. Log Page:
Address: Address: HDR No.:

Spec Section:

Drawing/Detail No.:

IAtin: Attn: 1st. Sub ReSub.
Date Transmitted: Previous Transmittal Date:
Item| No. Description Manufaclurer FMerendor Dwg or Data No.|  Action Taken*
No. | Copie
s
Remarks:

* The Aclion designated above is in accordance with the following legend:

A - Furnish as Submitted E - Engineer's review not required
; 1. Submittal not required.
B- Furrflsh Ssjiioted ) 2. Supplemental Information. Submittal retained for informational purposes only.
C - Revise and Submit ) 3. Information reviewed and approved on prior submittal,
1. Not enough information for 4. See comments.
review. . 5. Delegated Design - Submittal received as requested by the Contract
2. No reproducibles submitted. Documents. The Engineer did not review the engineering or technical content
3. Copies illegible. of the submittal,
4. Not enough copies
submitted. Engineer's review and approval will be only to determine if the items covered by the submittals
5. Wrong sequence number. will, after installation or incorporation in the Work, conform to the information given in the
6. Wrong resubmittal number. [Contract Documents and be compatible with the design concept of the completed Project as a
7. Wrong spec. section. functioning whole as indicated by the Contract Documents. Any deviation from plans or
8. Wrong form used. pecifications not depicted in the submittal or included but not clearly noted by the Supplier
9. See comments. ay not have been reviewed. Review by the Engineer shall not serve to relieve the Supplier of
D - Rejected Ee contractual responsibility for any error or deviation from contract requirements.
Comments:
By Dale
Distribution: Supplier | | File| | Field| | Owner| | Other] |
Copyright 1991-2013 HDR Engineering, Inc. - Revised July 2014
233305 City of Billings
W.0. 19-34: Headworks Screen Procurement -
SUBMITTALS

013300-EXHIBITA-1
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EXHIBIT AA Supplier's Submittal
Certification

Shop Drawing Transmittal No.:

Contract/Project Name:

Company Name:

has

1. reviewed and coordinated this Shop Drawing or Sample with other Shop Drawings and Samples and
with the requirements of the Work and the Contract Documents;

2. determined and verified all field measurements, quantities, dimensions, specified performance and
design criteria, installation requirements, materials, catalog numbers, and similar information with
respect thereto;

3. detemined and verified the suitability of all materials offered with respect to the indicated application,
fabrication, shipping, handling, storage, assembly, and installation pertaining to the performance of the
Work; and

4. determined and verified all information relative to Supplier's responsibilities for means, methods,
techniques, sequences, and procedures of construction, and safety precautions and programs incident
thereto.

O This Submittal does not contain any variations from the requirements of the Contract Documents.

O This Submittal does contain variations from the requirements of the Contract Documents. A separate
description of said variations and a justification for them is provided in an attachment hereto identified
as:

"Shop Drawing Transmittal No. Variation and Justification
Documentation"

Insert picture file or electronic signature of Authorized
Representative

Authorized Representative Date

Copyright 1991-2013 HDR Engineering, Inc. - Revised Oct 2011

233305 City of Billings
W.0. 19-34: Headworks Screen Procurement -
SUBMITTALS
01 33 00 - EXHIBIT AA- 1
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SECTION 01 33 04
OPERATION AND MAINTENANCE MANUALS

PART 1 - GENERAL

1.1

1.2

1.3

1.4

1.5

233305

SUMMARY

A. Section Includes:
1. Administration of the submittal process for Operation and Maintenance Manuals.
2. Content requirements for Operation and Maintenance Manuals.

B. Related Specification Sections include but are not necessarily limited to:
1. Section 01 33 00 — Submittals.
2. Section 46 21 53 — Perforate Plate Screens.

DEFINITIONS

A. Equipment Operation and Maintenance Manuals:
1. Contain the technical information required for proper installation, operation and
maintenance of process, electrical and mechanical equipment and systems.

SUBMITTALS

A. Operation and Maintenance Manuals:
1. Draft and final electronic copies.
2. Final paper copies: Two (2).

SUBMITTAL SCHEDULE

A. Draft Operation and Maintenance Manuals:
1. Submit approvable draft manuals in electronic format (PDF) within 30 days following
approval of the respective Shop Drawing.
a. Include placeholders or fly sheet pages where information is not final or is missing
from the draft manual.

B. Final Operation and Maintenance Manuals:

1. Final approval of Operation and Maintenance Manuals in electronic format (PDF) must be
obtained 45 days prior to equipment start-up.

2. Provide paper copies and CD-ROMs of approved final Operation and Maintenance Manuals
in electronic format (PDF), a minimum of 30 days prior to equipment start-up.

3. Issue addenda to Final Approved Operation and Maintenance Manual to include:
a. Equipment field testing data.
b. Equipment start-up reports.

PREPARATION OF SUBMITTALS

A. General:
1. All pages of the Operation and Maintenance Manual submittal shall be legible.
a. Submittals which, in the Engineer’s sole opinion, are illegible will be rejected without
review.
2. Identify each equipment item in a manner consistent with names and identification numbers
used in the Contract Documents, not the manufacturer’s catalog numbers.
3. Neatly type any data not furnished in printed form.
4. Qperation and Maintenance Manuals are provided for Owner's use, to be reproduced and
distributed as training and reference materials within Owner's organization.
a. This requirement is:
1) Applicable to both paper copy and electronic files.
2) Applicable to materials containing copyright notice as well as those with no
copyright notice.

City of Billings
W.O. 19-34: Headworks Screen Procurement -
OPERATION AND MAINTENANCE MANUALS
013304-1
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Notify supplier and/or manufacturer of the intended use of Operations and Maintenance
Manuals provided under the Contract.

B. Operation and Maintenance Manual Format and Delivery:
Draft electronic submittals:

1.

a.

b.
c.
d

Provide manual in Adobe Acrobat Portable Document Format (PDF), latest version.
Create one (1) PDF file for each equipment Operation and Maintenance Manual.
Do not password protect or lock the PDF document.
Drawings or other graphics must be converted to PDF file format from the original
drawing file format and made part of the PDF document.
Scanning of drawings is to be used only where actual file conversion is not possible and
drawings must be scanned at a resolution of 300 dpi or greater.
Rotate sheets that are normally viewed in landscape mode so that when the PDF file is
opened the sheet is in the appropriate position for viewing.
Create bookmarks in the bookmarks panel for the Operation and Maintenance Manual
cover, the Table of Contents and each major section of the Table of Contents.
Using Adobe Acrobat Standard or Adobe Acrobat Professional, set the PDF document
properties, initial view as follows:
1) Select File >Properties>Initial View.
2) Select the Navigation tab: Bookmarks Panel and Page.
3) Select the Page layout: Single Page.
4) Select the Magnification: Fit Page.
5) Select Open to page: 1.
6) Set the file to open to the cover page of the manual with bookmarks to the left, and
the first bookmark linked to the cover page.
Set the PDF file "Fast Web View" option to open the first several pages of the
document while the rest of the document continues to load.
1) To do this:
a) Select Edit->Preferences> Documents—> Save Settings.
b) Check the Save As optimizes for Fast Web View box.
PDF file naming convention:
1) Use the Specification Section number, the manufacturer’s name and the equipment
description, separated by underscores.
2) Example: 46 21 53 Peforated Plate Screens.pdf.
3) Do not put spaces in the file name.

Final electronic submittals:

a.

b.

Submit two (2) copies in PDF file format on two (2) CD-ROM discs (one (1) copy per
CD-ROM), each secured in a jewel case.
CD-ROM Labeling:
1) Provide the following printed labeling on all CD-ROM discs:
a) Project name.
b) Specification Section.
¢) Equipment names and summary of tag(s) covered.
d) Manufacturer name.
¢) Date (month, year).
CD-ROM Jewel Case Holder:
1) Insert jewel cases containing labeled CD-ROM discs in three-ring binder holder
(C-Line Products, www.c-lineproducts.com stock number CLI-61968 or
equivalent) at the front of each final paper copy.

Final paper copy submittals:

a.
b.

Quantity: Provide two (2) copies.

Paper: 8.5 x 11 INor 11 x 17 IN bright white, 20 pound paper with standard three-hole
punching.

3-Ring Binder:

1) Provide D-ring binder with clear vinyl sleeves (i.e. view binder) on front and spine.

City of Billings
W.0, 19-34: Headworks Screen Procurement -
OPERATION AND MAINTENANCE MANUALS
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2) Insert binder title sheet with the following information under the front and spine
sleeves:
a) Project name.
b) Specification Section.
¢) Equipment names and summary of tag(s) covered.
d) Manufacturer name.
e) Date (month, year).
3) Provide plastic sheet lifters prior to first page and following last page.
d. Drawings:
1) Provide all drawings at 11 x 17 IN size, triple folded and three-hole punched for
insertion into manual.
2) Where reduction is not practical to ensure readability, fold larger drawings
separately and place in three-hole punched vinyl envelopes inserted into the binder.
3) Identify vinyl envelopes with drawing numbers.
e. Use plastic coated dividers to tab each section of each manual in accordance with the
Table of Contents,

C. Equipment Operation and Maintenance Manual Content:

1.

Provide a cover page as the first page of each manual with the following information:

Manufacturer(s) Name and Contact Information.

Vendor’s Name and Contact Information.

Date (month, year).

Project Owner and Project Name.

Specification Section.

Project Equipment Tag Numbers.

Model Numbers.

h. Engineer’s Name.

Provide a Table of Contents for each manual.

Provide Equipment Record sheets as follows:

a. Printed copies of the Equipment Record (Exhibits B1, B2 and B3), as the first tab
following the Table of Contents.

b. Exhibits B1-B3 are available as Fillable PDF Form documents from the Engineer.

c. Each section of the Equipment Record must be completed in detail; simply referencing
the related equipment Operation and Maintenance Manual sections for nameplate,
maintenance, spare parts or lubricant information is not acceptable.

d. For equipment involving separate components (for example, a motor and gearbox), a
fully completed Equipment Record is required for each component.

e. Submittals that do not include the Equipment Record(s) will be rejected without further
content review.

Provide a printed copy of the Manufacturer’s Field Services report following the Equipment

Record sheets.

Provide the following detailed information, as applicable:

a. Use equipment tag numbers from the Contract Documents to identify equipment and
system components.

b. Equipment function, normal and limiting operating characteristics.

c. Instructions for assembly, disassembly, installation, alignment, adjustment, and
inspection.

d. Operating instructions for start-up, normal operation, control, shutdown, and

emergency conditions.

Lubrication and maintenance instructions.

Troubleshooting guide.

g. Mark each sheet to clearly identify specific products and component parts and data
applicable to the installation for the Project; delete or cross out information that does
not specifically apply to the Project.

h. Parts lists:

1) A parts list and identification number of each component part of the equipment.

R e a0 oP

™
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2) Exploded view or plan and section views of the equipment with a detailed parts
callout matching the parts list.
3) A list of recommended spare parts.
4) List of spare parts provided as specified in the associated Specification Section.
5) A list of any special storage precautions which may be required for all spare parts.
i.  General arrangement, cross-section, and assembly drawings.

j.  Electrical diagrams, including elementary diagrams, wiring diagrams, connection
diagrams, and interconnection diagrams.

k. Test data and performance curves.

. As-constructed fabrication or layout drawings and wiring diagrams.

m. Copy of the equipment manufacturer’s warranty meeting the requirements of the

Contract.
n. Copy of any service contracts provided for the specific piece of equipment as part of
the Contract.
6. Additional information as required in the associated equipment or system Specification
Section.

TRANSMITTAL OF SUBMITTALS

A. Operation and Maintenance Manuals.
1. Transmit all submittals to:

a. The address specified in Specification Section 01 33 00 - SUBMITTALS.

2. Transmittal form: Use Operation and Maintenance Manual Transmittal, Exhibit A.
3. Transmittal numbering:

a. Number each submittal with the Specification Section number followed by a series
number beginning with "-01" and increasing sequentially with each additional
transmittal, followed by "-OM" (for example: 46 21 53-01-OM).

4. Submit draft and final Operation and Maintenance Manual in electronic format (PDF) to

Engineer, until manual is approved.

ENGINEER'S REVIEW ACTION

A. Draft Electronic (PDF) Submittals:

1. Engineer will review and indicate one of the following review actions:
a. A-ACCEPTABLE
b. B -FURNISH AS NOTED
c. C-REVISE AND RESUBMIT
d. D-REJECTED

2. Submittals marked as Acceptable or Furnish As Noted will be retained; however, the
transmittal form will be returned with a request for the final paper and electronic documents
to be submitted.

3. Copies of submittals marked as Revise and Resubmit or Rejected will be returned with the
transmittal form marked to indicate deficient areas.

4. Resubmit until approved.

B. Final Paper Copy Submittals:

1. Engineer will review and indicate one (1) of the following review actions:
a. A-ACCEPTABLE
b. D-REJECTED

2. Submittals marked as Acceptable will be retained with the transmittal form returned as
noted.

3. Submittals marked as Rejected will be returned with the transmittal form marked to indicate
deficient areas.

4. Resubmit until approved.

City of Billings
W.0O. 19-34: Headworks Screen Procurement -
OPERATION AND MAINTENANCE MANUALS
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PART 2 - PRODUCTS - (NOT APPLICABLE TO THIS SPECIFICATION SECTION)

PART 3 - EXECUTION - (NOT APPLICABLE TO THIS SPECIFICATION SECTION)

END OF SECTION

233305 City of Billings
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EXHIBIT A Operation and Maintenance Manual
Transmittal - -OM

(Spec Section) (Series)

Project Name:

Date Received:

Project Owner:

Checked By:

Supplier: Owner:

Log Page:

Address: Address:

Attn: Attn:

HDR No.:

1st. Sub. ReSub.

Date Transmitted: Previous Transmittal Date:

No. Description of Item Manufacturer
Copies

Dwg. or Data No. Action Taken*

Remarks:

To From:
HDR Engineering, Inc.

Date:

*  The Action designated above is in accordance with the following legend:
A - Acceptable

B - Furnish as Noted

C - Revise and Resubmit

D - Rejected
Comments:

By Date
Distribution: Supplier [ | File |_ | Field | | owner | | Other | |

(Jun 1990; Revised Oct 2001, Revised Nov 2007, Revised 2013) Copyright 1991-2014 HDR Engineering, Inc.

233305 City of Billings
W.0. 19-34: Headworks Screen Procurement -
OPERATION AND MAINTENANCE MANUALS
013304 - EXHIBIT A -1
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EXHIBIT B1 Equipment Record

Equipment Data and Spare Parts Summary

Project Name pecification
clion:
Equipment Name ear

Project Equipment Tag No(s).

Equipment Manufacturer Froject/
rder No.
Address Phone
Fax rNeb Site lE—mall
Local Vendor/Service Center
Address [Phone
Fax ihmb Site ‘E-maﬂ
MECHANICAL NAMEPLATE DATA
Equip. Serial No.
Make Mode! No.
ID No. Frame No. HP RPM Cap.
Size TDH Imp. Sz. CFM PSI
Olher:
ELECTRICAL NAMEPLATE DATA
Equip. ISel‘ia! No.
Make IModel No.
1D No. Frame No. HP V. Amp. HZ PH RPM SF
Duty Code Ins. Cl. Type NEMA C Amb. Temp. Rise Rating
Other:
SPARE PARTS PROVIDED PER CONTRACT
Part No. Part Name Quantity
RECOMMENDED SPARE PARTS
Part No. Part Name Quantity

(Jun 1990; Revised Oct 2001, Revised Nov 2007, Revised 2013) Copyright 1991-2014 HDR Engineering, Inc.

W N

233305 City of Billings
W.0. 19-34; Headworks Screen Procurement -
OPERATION AND MAINTENANCE MANUALS
0133 04 - EXHIBIT B1- 1
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EXHIBIT B2 Equipment Record

Recommended Maintenance Summary

Equipment Description Project Equip. Tag No(s).
INITIAL COMPLETION *
FOLLOWING START-UP
RECOMMENDED BREAK-IN MAINTENANCE (FIRST OIL CHANGES, ETC.) D|W|M|Q|S]|A|RT| Hours
PM TASK INTERVAL *
RECOMMENDED PREVENTIVE MAINTENANCE pD(wim|a|s|A[RT| Hours
* D=Daily W = Weekly M = Monthly Q = Quarterly S = Semiannual A = Annual Hours = Run Time |

(Jun 1990; Revised Oct 2001, Revised Nov 2007, Revised 2013) Copyright 1991-2014 HDR Engineering, Inc

233305 City of Billings
W.O. 19-34: Headworks Screen Procurement -
OPERATION AND MAINTENANCE MANUALS
013304 -EXHIBITB2-1
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EXHIBIT B3 Equipment Record

Lubrication Summary
Equipment Description IF'ruject Equip. Tag No(s).

Lubricant Point

Manufacturer Product AGMA # SAE # 1ISO

Lubricant Type

1
2
3
4

5
Lubricant Point

Manufacturer Product AGMA # SAE # 1ISO

Lubricant Type
aAlw|n

lLubricant Point

Manufacturer Product AGMA # SAE # 1SO

Lubricant Type

ala|l@IN| =

Lubricant Point

Manufacturer Product AGMA # SAE # 1ISO

Lubricant Type

alh|jlOIN|=

Lubricant Point

Manufacturer Product AGMA # SAE # ISO

Lubricant Type

| IN| =

Lubricant Point

Manufacturer Product AGMA # SAE # I1SO

Lubricant Type

1
2
3
4

5
(Jun 1990; Revised Oct 2001, Revised Nov 2007, Revised 2013) Copyright 1991-2014 HDR Engineering, Inc.

233305 City of Billings
W.0. 19-34: Headworks Screen Procurement -
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013304 - EXHIBITB3 - 1
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1.1

ExhibA A Z

SECTION 46 21 53
PERFORATED PLATE SCREENS

GENERAL

SUMMARY

A. Section Includes:

1.

2.

Mechanically cleaned influent perforated plate screen, motor, gear reducers, and lifting
attachments to ensure proper coordination, compatibility, and operation of the system.

The equipment specified herein is intended to be identical to existing equipment currently in
operation at the Billings Water Reclamation Facility. All components of the new equipment
shall be identical to existing equipment unless specifically noted by the supplier and
approved by the engineer during the Shop Drawing phase prior to equipment fabrication and
delivery. Owner reserves the right to install existing spare part inventory on new equipment
to verity compatibility at their discretion. In the event existing spare part components are
not compatible with new equipment, supplier will provide new, matching equipment, at no
additional cost to the Owner.

B. Tag Numbers.

1.

Perforated Plate Screen No. 4: HWB-SCRN-4,

C. Related Sections include but are not necessarily limited to:

1.
2.

Section 01 33 00 — Submittals.
Section 01 33 04 — Operations and Maintenance Manuals.

D. Description:

1.

2.

One perforated plate Influent Screen as specified herein will be installed in the Headworks
Building.

The new Influent Screen shall remove debris from the raw wastewater and deposit it into an
existing sluice. The deposited screenings will then be sluiced to the existing washer
compactors.

1.2 QUALITY ASSURANCE

233305

A. Referenced Standards:

1.
2.
3.

4.

wn

American Bearing Manufacturers Association (ABMA):

American Gear Manufacturers Association (AGMA).

American Iron and Steel Institute (AISI):

a. Steel Products Manual.

All structural stainless steel components shall conform to the requirements of “Specifications

for the Design, Fabrication, and Erection of Structural Steel Buildings” published by the

American Institute of Steel Construction (AISC).

American National Standards Institute (ANSI).

American Society of Mechanical Engineers (ASME):

a. B1.20.1, Screw Threads - Pipe Threads, General Purpose (Inch).

b. B16.1, Gray Iron Pipe Flanges and Flanged Fittings (Classes 25, 125 and 250).

American Society of Testing and Materials International (ASTM):

a. A193, Standard for Alloy-Steel and Stainless Steel Bolting Materials for High-
Temperature Service.

b. A194, Standard for Carbon and Alloy Steel Nuts for Bolts for High-Pressure and High-
Temperature Service, or Both.

c. A320, Standard for Alloy Steel Bolting Materials for Low Temperature Service.

d. A380, Standard Practice for Cleaning, Descaling, and Passivation of Stainless Steel
Parts, Equipment, and Systems.

City of Billings
W.0. 19-34: Headworks Screen Procurement -
PERFORATED PLATE SCREENS
462153-1
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e. A480/A480M-90, General Requirements for Flat-Rolled Stainless and Heat Resisting
Steel Plate, Sheet, and Strip.
f. (881, Standard for Epoxy-Resin-Base Bonding Systems for Concrete.
g. (882, Standard Test Method for Bond Strength of Epoxy-Resin Systems Used With
Concrete by Slant Shear.
h. D648, Standard Test Method for Deflection Temperature of Plastics under Flexural
Load in the Edgewise Position.
i. D695, Standard Test Method for Compressive Properties of Rigid Plastics.
8. National Electrical Manufacturers Association (NEMA):
a. 250, Enclosures for Electrical Equipment.
b. ICS 6, Enclosures for Industrial Control and Systems.
c. MGI, Motors and Generators.
9. National Fire Protection Association (NFPA):
a. 70, National Electric Code (NEC).
b. 820, Standard for Fire Protection in Wastewater Treatment and Collection Facilities.
10. Occupational Safety and Health Administration (OSHA).
11. Underwriters Laboratory (UL):
a. Standard for Safety Industrial Control Equipment.

Responsibilities and Qualifications:

1. All equipment provided under this Specification Section shall be obtained from a single
manufacturer who shall assume full responsibility for designing and furnishing a complete
and operational influent screening.

a. The manufacturer shall be the source of information on all equipment furnished
regardless of the manufacturing source of that equipment.

2. Manufacturer’s qualifications:

a. Manufacturer shall have experience in manufacturing in-channel, perforated plate
traveling belt screen equipment of similar size and configuration to the equipment
specified herein in service in USA.

3. Statements of qualification: Professional structural engineer.

4. The Contract Documents represent the minimum acceptable standards for equipment for this
Project.

a. All equipment will conform fully in every respect to the requirements of the respective
parts and sections of the Drawings and Specifications.

Definitions:
1. Screen Height: The height between the operating floor and the top of the perforated plate
screens.

2. Discharge Height: The height between the operating floor and the screenings discharge.

3. Head Loss: Total difference in elevation of the water level upstream of the upstream
screening elements and downstream of the downstream return elements.

4. Percent Blinded: Percentage of submerged area of partially blinded perforations relative to
total area of non-blinded perforations.

5. Maximum Differential Head: Maximum difference in elevation of the water level upstream
and downstream of the upstream screening elements that the screen will experience during
emergency conditions (i.e. screen fully plugged).

6. Capture Efficiency: Percentage of material larger than screen perforation size captured by
the screen.

7. Screen Angle: Angle of screen frame incline from horizontal plane parallel with mounting
floor.

1.3 SUBMITTALS

233305

A.

Shop Drawings:

1. See Specification Section 01 33 00 for requirements for the mechanics and administration of
the submittal process.

2. Product technical data including:
a.  Acknowledgement that products submitted meet requirements of standards referenced.

City of Billings
W.0. 19-34; Headworks Screen Procurement -
PERFORATED PLATE SCREENS
462153-2
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10.
11.
12.

13.

14.

15.

16.
17.

18.
19.

20.
21.
22.
23.

24.

Exhibt A s

b. Manufacturer’s installation instructions.

¢. Manufacturer’s catalog information, descriptive literature, specifications, and
identification of materials for construction.

Detailed Structural, Mechanical, and Electrical Drawings showing equipment fabrications

and interface with other items including:

a. Dimensions, size, and locations of connections to other work.

b. Details of attachment and support in channel.

Gear output torque.

Hydraulic calculations and flow curves for the proposed screen verifying that the screen is

capable of processing the peak flow.

Complete motor nameplate data, as defined by NEMA, motor manufacturer, and motor

modifications.

Functional description of internal and external instrumentation and controls including list of

parameters monitored, controlled, or alarmed.

Shop painting systems, including manufacturer’s descriptive technical catalog literature and

specifications.

External utility requirements for air, water, power, drain, etc., for each component.

Spare parts list.

Training course outlines.

Certifications:

a. Manufacturer’s Certificate of Compliance of factory-applied coating system.

b. Manufacturer’s Certificate of Proper Installation.

Test reports:

a. Written factory test report of inspection.

b. Field functional test reports.

Structural calculations showing that the screen can operate under the specified Maximum

Differential Head with the specified deflection and factor of safety:

a. The calculations are to be stamped, dated, and signed by a currently registered
professional engineer in structural engineering.

Head loss calculations for the influent screens at peak influent flow assuming a zero percent

blinded condition, and a 20 percent blinded condition:

a. Factory or field test data for screens similar in size and flow loading demonstrating the
accuracy of the head loss calculation used.

Describe the method of checking and adjusting drive chain tension.

Drawings showing the proposed screens in plan and section installed in the Plant, at a scale

of no smaller than % IN equals one FT:

a. Label all components.

b. Show dimensions and total weight of the screen.

c. All dimensions of existing structure are to be field verified by the Vendor.

d. Provide fabrication and installation details, including details of access/view panels in
the screen cover and frame.

e. Provide details of the area at the bottom of the screen to show how the screen will pick
up large objects off the channel floor, assuming a six-inch channel step-down at base of
screen.

f.  Provide details of the bottom of the screen that shows the method employed to prevent
buildup of grit and small stones beneath the screen and to prevent wear on the screen
elements.

Flow rate and pressure of spray water system for each screen.

Detailed specifications including a complete description of screen materials (type, thickness,

load rating, etc.).

A recommended list of spare parts (indicate if for each screen, or for the entire set of

screens).

Catalog cuts of all components including valves, tubing, switches, etc.

Certification of equipment frame, roller, and bearing design safety factor.

Electric motor operator data, including Vendor's catalog information, complete dimensional

data, drive unit size, calculations substantiating selection.

Provide factory testing procedure and setup as specified in paragraph 1.05 A.

City of Billings
W.O. 19-34: Headworks Screen Procurement -
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28
29
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25. Anchorage calculations and details.
26. Installation instructions.

Reports and Forms:

L.
2.
1.

Factory test report.

Field test reports. Operation and Maintenance Manuals:

See Specification Section 01 33 04 for requirements for:

a. The mechanics and administration of the submittal process.

b. The content of Operation and Maintenance Manuals.

Operation and Maintenance Manual, including routine maintenance requirements prior to
plant start-up.

Informational Submittals:

1.

w

Provide structural design calculations by a Professional structural engineer to support the
structural design of the screen and anchors to withstand the worst case load on the screen at
maximum upstream water level in the channel with no water in the downstream channel.
Special shipping, storage and protection, and handling instructions.

See Specification Section 01 33 00 for requirements for:

a. The mechanics and administration of the submittal process.

1.4 DESIGN REQUIREMENTS

A. Performance and Configuration Requirements for Influent Screens:
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Number of Influent Screens: 1 each.

Screen Angle: 60 Degrees.

Maximum Screen Height: 9.0 FT, above finished floor elevation of 3093.10.
Discharge Outlet Opening Size: Max 4 FT Long, Min 4 FT Wide.
Discharge Height: 4.5 FT, above finished floor elevation.

Average Annual Flow (Per Screen): 8.5 mgd.

Average Wet Weather Flow (Per Screen): 13 mgd.

Peak Flow (Per Screen, 3 Screens in Service): 20 mgd.

Channel Width: 4.0 FT.
Channel Depth: 7.5 FT.
Water Depth Downstream of Screen at Average Wet Weather Flow: 3.3 FT.

Water Depth Downstream of Screen at Peak Flow: 3.5 FT.

Maximum Head Losses across Screen at Peak Flow:
Zero percent blinded: 0.65 FT.

20 percent blinded: 1.0 FT.

Screen Panel Perforation Diameter: 6 mm.

Maximum Differential Head: 1 FT.
Area of each Screen below the Operating Floor: 9.6 SQ FT.

B. Equipment Anchoring:

1.

Equipment shall be designed to resist seismic forces as required by the 2012 Uniform
Building Code.

1.5 SOURCE QUALITY CONTROL

233305

A.

Factory Tests:

1. Prior to shipment conduct factory tests on each screen.

2. The Vendor shall submit a description of the proposed testing procedure to the City at least
10 weeks in advance of the proposed testing date. In addition, the Vendor shall provide the
City with at least 4 weeks advance written notice of the date and location of the factory tests.

3. Tests shall address the following items as a minimum:

City of Billings
W.0, 19-34: Headworks Screen Procurement -
PERFORATED PLATE SCREENS
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a. Running test with minimum of four hours of continuous operation.
Functional test of the field panel operation.
¢. Demonstrate that all equipment is capable of continuous operation in satisfactory
manner without mechanical or electrical defects or operational difficulties.
d. If necessary, repeat tasks until satisfactory results are obtained.
e. Produce a test report containing quantitative results in the form of data or charts.
4. The test results shall be signed and certified by an officer of the Vendor.

1.6 ENVIRONMENTAL CONDITIONS

A. The screen will be installed indoors in the Headworks Building at the City Billings WRF,
Billings, MT.

B. Elevation is approximately 3,100 feet above mean sea level.

C. All screens shall be rated for installation in a Class I, Division 2 location.

1. Equipment, electrical assemblies, related electrical wiring, instrumentation, controls, and
system components shall FULLY comply with specific NEC requirements related to area
classification and to NEMA 250 and 1CS-6 designations specified herein.

2. All equipment supplied under this contract shall be suitable for operation in a Class I,
Division 2 area classification, except for field panels to be located in unclassified areas as
specified.

D. 15 gpm of plant process wash water under 50 to 100 psig of supply pressure will be provided to
the influent screens.

1.7 SPARE PARTS

A. The items listed in this paragraph are representative of the spare parts required for each screen.
Vendors are to add, modify, or delete items from the list as appropriate for each Vendor’s
equipment.

B. Provide one set of special tools to accommodate servicing of all screens.

C. Provide one complete replacement of the following items:
Bottom sprocket.

Top sprocket.

Top sprocket tension frame bearing.

Replacement drive chain with master link connection pieces.
Screen perforated plate panel.

Rotating brush.

Side seals and curved seals.

Bottom brush.

Each type of motor.

10 Each type of gear reducer.

NS CopinC) thgd=aty DS

D. All parts are to be suitably marked by part number referenced to the Vendor’s O & M manual.

PART 2 - PRODUCTS

2.1 EQUIPMENT LIST:

Equipment No. Equipment Name:
HWB-SCRN-4 Screen 4

Provide all required anchor bolts for all screens.
2.2 ACCEPTABLE MANUFACTURERS

A. FSM.

233305 City of Billings
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2.3 MATERIALS
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A. Frame: 304L Stainless Steel.

B. Screen Panels: 316L or 304 Stainless Steel.

C. Screen Covers: 304L Stainless Steel.

D. Drive Chain: 304L Stainless Steel.

E. Discharge Outlet: 304L Stainless Steel.

F. Access Panels in Screen Frames: 304L Stainless Steel.

G. Access/View Panels in Screen Covers: % IN clear Plexiglas.
H. Rotating Deflector: 304 Stainless Steel.

EQUIPMENT FEATURES

A. Screen Panels:

1. The perforated plate screens are to have the proven capability to operate at Maximum
Differential Head conditions without permanent deflection of any the screen components
(use a factor of safety of 2).

2. Maximum deflection of any of screen panels: “-IN.

3. Lifting fingers shall be placed on every tenth filter plate. The lifting fingers shall be located
on the filter element to remove spherical solids from the bottom of the channel.

B. Capture Efficiency:

1. Maximum gaps between the screen panels: 3 mm.

2. Lateral edges of the panel are to be of sufficiently rigid construction and securely held in
proper alignment to prevent any suspended or floating debris from passing between the
panels up to specified Peak Flow.

C. Screen Travel Speed:

1. Each screen shall have a travel speed that will quickly remove debris from the channel, and
quickly return clean screen panels into the channel for further debris removal:

a. High travel speeds are critical for efficient debris removal as well as to limit the head
loss across the screen since the percent blinding increases in direct proportion to the
time the panel is exposed to the wastewater flow in the channel.

b. Screens shall have a two-speed drive capable of continuously operating at Peak Flow
throughput up to a maximum screen travel speed of 30 feet per minute (FPM).

D. Screen Drive Mechanism:

1. Motor: Max 2 HP, Two Speed, 460 V, 3 Phase, 60 Hz, TEFC.

2. Gear Reducer:

a. Hollow, shaft type.

b. Anti-friction bearings.

3. Low friction/wear resistant chain guides and other panel alignment features that allow high
speed operation.

4. The drive chain is to be continuously supported on the downstream side of the influent
screen.

E. Maintenance Features:

1. Screen Panel Removal:

a. The screen shall be designed to allow removal of individual screen panels at the
operating floor level without taking the screen out of the channel or limiting the ability
to continuously or intermittently rotate the screen.

b. The screen panels are to be removable by unbolting connections between the screen
panel and the drive chain on both sides of the panel.

¢. The connections are to be accessible through the access panels in the screen frames
specified below.

2. Access Panels in Screen Frames:

a. Provide access panels on the frames on each side of the screen to allow removal of the
screen panels, or checking the chain tension.

City of Billings
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b. Approximately 10 IN x 12 IN with quick release fittings.

c. Approximately 48 IN above the operating floor level.

Access/View Panels in Screen Covers:

a. The front and back covers on each screen are to be provided with a clear Plexiglas
access panel to allow viewing the screen in operation and for cleaning the screen panels.

b. Minimum size:

1) 36 IN wide x 24 IN high.

c. Equip with durable seals that are retained and protected by framework welded to the
cover plates.

d. Front panels shall have quick-release fittings and back panels shall be hinged.

Discharge Chute/Hood:

a. A discharge chute/hood shall be provided that fully encloses the discharge section of the
screen. The upper section of the discharge chute/hood shall be hinged to allow complete
access to the screen cleaner brush and when opened will rotate downwards towards the
floor. The removable or hinged hood shall be secured with quick closing clamps and
supplied with two (2) gas cylinders to aid in opening and closing. Gas cylinders shall
hold the discharge hood in the open position without need for clamps or support rods.
Discharge hoods that rotate upwards allowing debris to fall on top of operators and
require securing clamps or rods to hold in the open position shall not be allowed.

b. The discharge chute/hood shall be from type 304 stainless steel.

¢. Screen discharge chute/hood shall direct screenings directly to the compactor or other
device. Outlet shall extend down to the inlet of the compactor and shall be designed to
match the screenings compactor inlet hopper with no water leaking or screenings
dropping to the floor.

d. Provide hinged access panels on the discharge hood on each side of the screen to allow
for visual inspection.

Drive Chain Tensioning:

a. Provide to minimize chain, drive sprocket, and bearing wear.

b. Accurately maintain the tension of the screen drive chain and screen panel alignment.

c. Accomplished without removing the screen from the channel, or pivoting the screen out
of the channel.

. Tensioning shall not require the removal of any screen cover plates, or guards.

e. Chain tensioning devices shall be readily accessible heavy-duty jacking screws located

on each side of the motor drive shaft.

F. Cleaning Mechanism:

1.

The screen shall have an efficient cleaning system to completely remove collected debris
from the screen panels, and prevent the “carry-over” and accumulation of debris to the
downstream side of the screen, or the entrapment of material and gradual plugging of the
screen perforations over time:

a. Provide heavy-duty rotating brush or other method to clean the screen.

b. The motorized cleaner brush will automatically adjust as the brush wears during use.
The automatic adjustment will maintain consistent cleaning efficiency. The distance
between the cleaner brush and filter panels will be automatically controlled to ensure
the distribution and magnitude of pressure is equal across the entire filter panel surface.
Screens with rotating cleaner brushes requiring manual adjustment or adjustment with a
motor shall not be permitted.

c. Ifbrushes are employed, the shape of the screen panels shall promote complete contact
with the rotating brush, with no sharp angles that would make the panels difficult to
clean.

d. Ifbrushes are employed, brush-tensioning devices shall be provided on the outside of
the screen frame to allow the adjustment of the brush to maintain the desired contact
pressure with the screen panels.

Spray Water:

a. Provide spray water quick connection for optional use by the Plant staff for manual
intermittent cleaning the internal surfaces of the screen panels.

City of Billings
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b. Spray water, which will be disinfected and screened secondary effluent in limited supply
at the Plant, shall not run continuously to accomplish cleaning.
1) The influent screens shall not use more than 15 gpm per screen of spraywater with
manual connection of hose to 1” NPT connection provided on screen.

Brush Drive Mechanism:
1. Motor: Max 5 HP, 1760 RPM, 230/460 V, 3 Phase, 60 Hz, TEFC.
2. Gear Reducer:

a. Hollow, shaft type.

b. Anti-friction bearings.

Rotating Deflector Drive Mechanism:
1. Motor: Max 1.5 HP, 1760 RPM, 230/460 V, 3 Phase, 60 Hz, TEFC.
2. Gear Reducer:

a. Hollow, shaft type.

b. Anti-friction bearings.

Seals:

1. All spaces between the edges of the screen panels and the screen frame shall be effectively
sealed to prevent debris from bypassing the screen panels:
a. Seals shall employ sealing fins that maintain a maximum 3 mm space with plates welded

on the outer edges of the screen panel.

b. The use of plastic brush seals to seal the edges of the screen shall not be permitted.

2. All seals shall be replaceable without requiring removal of the screen from the channel.

3. The space between the bottom of the screen and the lowest panel shall be sealed with dense,
durable brush material securely held in place by a bolted replaceable retainer.

Bearings:

1. All bearings shall be grease or oil lubricated.

2. Minimum L-10 rating life of 100,000 hours unless otherwise specified based on an average
operating speed of one half of the maximum speed.

3. Rated in accordance with the latest revisions of ABMA Methods of Evaluating Load Ratings
of Ball and Roller Bearings.

4. Except for those specified to be factory sealed and lubricated, equip all grease lubricated
bearings with easily accessible grease supply, flush, drain, and relief fittings:
a. Fit with extension tubes that extend three feet above the operating floor when necessary.

Gear Reducers:
1. All gears are to be fitted with anti-friction bearings and designed in accordance with AGMA
recommendations for 24 HR, Class II service.

Discharge Outlet:

1. Each screen shall be equipped with a discharge chute to transfer screenings to the screen
hopper.

2. The discharge outlet shall be enclosed and integral to the screen frame. Outlet shall extend
down to screen hopper three feet above finished floor.

3. Discharge chute’hood shall be as described in Paragraph 2.4.E 4.

Threaded-Rod Anchors:

1. Provide minimum diameter of 3/8 IN.

2. Anchor Rod: Type 316 stainless steel threaded rod free of grease, oil, or other deleterious
material with a 45-degree chisel point.

3. Will be installed under a separate contract.

2.5 ACCESSORIES

233305

A.

Equipment Identification Plates:
1. Provide a 16-gauge stainless steel identification plate securely mounted on each screen and
on each field panel in a readily visible location.
2. Plate shall bear the % IN die-stamped equipment identification number as indicated in this
Specification and shown on the drawings.
City of Billings
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B. Lifting Lugs: The equipment shall be provided with lifting lugs.
1. Provide one set of lifting lugs four feet from the end of the screen frame for tipping the
screen out of the channel.

2.6 FINISHES
A. Stainless steel components shall be provided with an ASTM 480, No.1 finish.

B. All non-machined surfaces other than galvanized or stainless steel shall be shop painted with
Vendor’s standard coating.

PART 3 - EXECUTION

3.1 GUARANTEES

A. The screens shall be unconditionally guaranteed to meet or exceed design criteria detailed in Part
2 of this specification.

B. The screen Vendor shall provide a two-year unconditional guarantee from startup or 30 months
from delivery, whichever is sooner.

3.2 FIELD QUALITY CONTROL

A. Field Tests:

1. Upon completion of the installation, each screen unit shall be field tested to ensure
compliance with the performance requirements as specified. Sellor shall be responsible for
the following:

a. Demonstration of the accuracy of the head loss performance claims submitted.

b. Demonstration of the ability of the screen to remove large debris by lifting a spherical
object of a minimum diameter of 4-IN off the bottom of the channel immediately
upstream of the screen.

2. Testing procedures shall duplicate as nearly as possible the conditions of operation and shall
be selected to demonstrate that the equipment is operational and free from damage.

3. The Installation Contractor shall demonstrate that the influent screens and associated field
panels operate according to the Specifications with assistance from the Seller.

4. The Seller shall observe the tests and sign the test forms.

B. Seller’s Services:
1. Provide the following Seller’s Services to be completed in a minimum of one 2 day trip:

a. Installation check for each screen including:

1) Confirm the equipment has been installed in accordance with Seller’s
requirements and is ready for operation.

2) Initial lubrication.
3) Alignment.

b. Startup including:
1) Unattended trouble free operation.
2) Process stabilization.
3) Balancing and proper control system operation.

c. Training:
1) Provide 4 hours of the manufacturer's technical representative's time for on-site

training of Owner's personnel.

END OF SECTION

233305 City of Billings
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